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UNIT 1 

INTERNET SKILLS AND COMPUTER BASICS 

Basic Internet Skills • Browser Usage • Search Engines • Digital India • Computer Hardware 
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BASIC INTERNET SKILLS 

What is the Internet? 

The Internet is a global network of interconnected computers and devices that communicate with each other 

using standardized communication protocols. It enables the sharing of resources, information, and services 

across geographical boundaries. The Internet connects millions of networks belonging to private 

organizations, public institutions, academic bodies, businesses, and government agencies, forming a unified 

global communication infrastructure. 

 

The Internet operates on a client-server model, where users access data and services hosted on remote 

servers through their local devices. The standardized protocols, primarily TCP/IP (Transmission Control 

Protocol/Internet Protocol), ensure that data is transmitted reliably and consistently regardless of the 

hardware or software used at either end of the communication. 

 

 

Common Applications of the Internet 

The Internet serves a wide range of purposes across personal, professional, and institutional domains. The 

major applications are as follows: 

• Global Connectivity — The Internet connects millions of private, public, academic, business, and 
government networks worldwide, enabling seamless interaction across countries and continents. 

• Communication — It enables communication through various means, including Email (Electronic 
Mail), Instant messaging, Voice and video calls, and Social media platforms. 

• Information Sharing — The Internet facilitates access to vast amounts of information stored on 
servers and computers around the world through Websites, Search engines, and Online databases. 

• E-Commerce — It supports online shopping, digital payment systems, and financial transactions 
between buyers and sellers across the globe. 
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• Collaboration — The Internet enables real-time collaboration on projects, sharing of documents, 
and simultaneous editing across different geographical locations using cloud-based tools. 

• Entertainment — It provides access to a wide variety of entertainment content, including Video 
and audio streaming services, Online gaming platforms, and Multimedia content distribution. 

 

Glossary for Internet Basics 

Term Full Form Definition 

Internet Internetwork A global network connecting millions of private, public, academic, 

business, and government networks for communication and data 

exchange. 

WWW World Wide Web A system of interlinked hypertext documents and multimedia content 

accessed via the Internet using web browsers. 

URL Uniform Resource 

Locator 

The specific address used to locate a web page or resource on the 

Internet. 

Web Browser — Software application used to access, retrieve, and view websites and 

web content. Examples include Chrome, Firefox, and Safari. 

HTML Hypertext Markup 

Language 

The standard markup language used for creating, structuring, and 

designing web pages. 

HTTP Hypertext Transfer 

Protocol 
The application-layer protocol used to transfer hypertext data over the 

Internet. 

HTTPS Hypertext Transfer 

Protocol Secure 
An encrypted and secure extension of HTTP that ensures safe 

communication between a browser and a web server. 

Server — A computer or system that provides resources, data, or services to 

other computers (clients) over a network. 

IP Address Internet Protocol 

Address 

A unique numerical identifier assigned to each device connected to a 

network, used for identification and communication. 

Domain Name — A human-readable address used to identify a website on the Internet, 

such as google.com. 

DNS Domain Name 

System 

A hierarchical system that translates human-readable domain names 

into machine-readable IP addresses. 

ISP Internet Service 

Provider 
A company or organization that provides users and institutions with 

access to the Internet. 

Router — A networking device that forwards data packets between different 

computer networks, directing traffic along optimal paths. 

Modem Modulator-

Demodulator 

A device that modulates digital signals into analog signals for 

transmission and demodulates received analog signals back into 

digital form. 
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Term Full Form Definition 

Bandwidth — The maximum rate of data transfer across a network or Internet 

connection, typically measured in bits per second. 

Cookie — A small piece of data sent by a website and stored on the user's device 

to track browsing activity and preferences. 

Firewall — A network security system that monitors and controls incoming and 

outgoing network traffic based on predefined security rules. 

Phishing — A type of cyber attack where fraudulent emails or websites are used 

to deceive users into revealing sensitive personal information. 

Malware Malicious Software Software intentionally designed to cause damage, disrupt operations, 

or gain unauthorized access to computers, networks, or data. 

Cloud 

Computing 

— The delivery of computing services such as servers, storage, 

databases, networking, and software over the Internet. 

 

1.1 UNDERSTANDING A BROWSER 

What is a Web Browser? 

A web browser is a software application specifically designed to access, retrieve, and display web pages 

and other resources available on the Internet. It interprets HTML documents, applies CSS stylesheets for 

visual formatting, and executes JavaScript code to render web pages in a visually understandable format 

for users. The browser acts as the primary interface between the user and the World Wide Web, enabling 

seamless navigation across websites and online services. 
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Components of a Web Browser 

A web browser consists of several integrated components, each performing a specific function to ensure 

efficient retrieval and display of web content. 

• User Interface (UI) — The graphical interface through which users interact with the browser. It 
includes Menus and toolbars, Address bar (for entering URLs), and Navigation buttons (Back, 
Forward, Refresh, Home). 

• Rendering Engine — The core component responsible for interpreting HTML, CSS, and 

JavaScript to visually display web pages. Google Chrome uses the Blink engine; Mozilla Firefox 
uses the Gecko engine. 

• Browser Engine — Acts as a coordinator between the rendering engine and the user interface, 
managing the flow of instructions and data between these two components. 

• Networking Component — Handles all communication between the browser and web servers 
over the Internet using HTTP and HTTPS protocols. 

• JavaScript Engine — Executes JavaScript code embedded within web pages, enabling interactive 
and dynamic content such as animations, form validations, and real-time updates. 

• Browser Extensions and Add-ons — Optional software tools that extend and enhance browser 
functionality, such as ad blockers and password managers. 

• Storage — Manages the local storage of browsing data, including Cookies, Cached files, and 
Session data. 

• Security Features — Built-in mechanisms including HTTPS support, phishing protection and 
warning systems, and sandboxing to isolate web page processes. 

 

How a Browser Interacts with the Internet 

• Requesting Web Pages — When the user types a URL or clicks a hyperlink, the browser sends an 
HTTP or HTTPS request to the hosting server. 

• Receiving and Rendering — The server responds by sending the requested content (HTML, CSS, 
JavaScript, images). The browser interprets and renders this content on the user's screen. 

• Executing Scripts — JavaScript code is executed by the JavaScript engine, allowing the page to 
modify content dynamically, handle user input, and communicate with servers using AJAX. 

• Caching — The browser stores copies of frequently accessed resources in local storage to speed 
up subsequent visits. 

• Security Checks — The browser verifies website authenticity through HTTPS certificates and 
warns users about potentially malicious websites. 

 

Popular Web Browsers 

Browser Developer Key Characteristics 

Google Chrome Google Known for speed, stability, and extensive built-in 

developer tools. Uses the Blink rendering engine. 

Mozilla Firefox Mozilla Foundation Emphasizes user privacy, offers extensive customization, 

and is open-source software. Uses the Gecko rendering 

engine. 



Introduction to IT Systems | DRIEMS Polytechnic, Tangi, Cuttack  |  Er. Sambit Kumar Sahoo 

DRIEMS Polytechnic  —  IT Theory  —  Page 8  of  87 

Browser Developer Key Characteristics 

Apple Safari Apple Inc. Integrated with macOS and iOS devices. Focuses on 

performance optimization and energy efficiency. 

Microsoft Edge Microsoft Built on the Chromium engine. Includes Cortana 

integration and compatibility with Windows services. 

 

Components of a Web Browser — Summary Table 

Component Function 

User Interface (UI) Provides address bar, navigation buttons, tabs, and bookmarks for user 

interaction. 

Browser Engine Bridges the User Interface and Rendering Engine by translating user actions 

into executable commands. 

Rendering Engine Parses HTML, CSS, and JavaScript to construct and display the visual 

layout of web pages. 

Networking Handles HTTP/HTTPS requests and responses for retrieving web content 

from servers. 

JavaScript Engine Executes JavaScript code to enable dynamic and interactive web page 

functionality. 

Storage Stores cookies, cached files, and session data locally for faster and 

personalized browsing. 

Security Features Provides HTTPS support, phishing protection, and sandboxing for user 

safety. 

 

Elements of a Chrome Browser Window 

Element Purpose 

Menu Button Opens a menu providing access to settings, history, and extensions. 

Title Bar Displays the title of the currently active web page. 

Profile Icon Provides access to Google account settings and synchronization. 

Extensions Displays icons of installed browser extensions on the toolbar. 

Overflow Menu Provides access to additional extensions not visible on the toolbar (puzzle piece 

icon). 

Search/Address Bar Accepts URL entries and search queries. 

Back Button Navigates to the previously visited page. 

Forward Button Navigates to the next page after using the Back button. 
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Element Purpose 

Reload Button Refreshes the current web page. 

Bookmark Button Saves the current page as a bookmark. 

Tabs Displays titles of open pages and enables switching between them. 

Web Page Display Area Renders and displays the content of the active web page. 

Download Bar Shows download progress and provides access to downloaded files. 

 

Common Browser Features 

Tabs and Tab Management 

• Tab Switching — Switch between multiple open web pages. 

• Tab Pinning — Pin frequently visited websites as small persistent tabs. 

• Tab Grouping — Organize related tabs into named groups. 

• Tab Muting — Mute audio from specific tabs. 

Address Bar (Omnibox) 

• URL Entry — Enter website addresses directly. 

• Search Functionality — Perform web searches from the address bar. 

• Autocomplete — Suggests URLs or search terms as the user types. 

Navigation Controls 

• Back and Forward Buttons — Navigate through previously visited pages. 

• Reload/Refresh Button — Reload the current web page. 

• Home Button — Return to the default home page. 

Privacy and Security 

• Incognito/Private Mode — Browse without saving history or cookies. 

• Password Manager — Securely store and auto-fill passwords. 

• Do Not Track — Request websites not to track browsing activity. 

• Pop-up Blocker — Prevent unwanted pop-up windows. 

Developer Tools 

• Console — Debug JavaScript errors and runtime logs. 

• Inspector — Examine and modify HTML structure and CSS styling. 

• Network Monitor — Analyze network requests and page loading performance. 
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1.2 EFFICIENT USE OF SEARCH ENGINES 

Introduction to Search Engines 

A search engine is a software system designed to carry out web searches by locating and retrieving 

information from the Internet based on user queries. It enables users to find specific information from the 

vast amount of data available across millions of websites and online resources. Efficient use of search 

engines significantly enhances the ability to find relevant and accurate information quickly. 

 

Key Components of a Search Engine 

1. Web Crawler (Spider/Bot) 

Function: Automatically browses the World Wide Web and collects data from websites. The crawler visits 

web pages, reads content, and follows hyperlinks to discover and gather data from additional pages. This 

process is continuous and systematic. 

2. Indexing 

Function: Organises and stores collected data in a structured format. Information is indexed and categorised 

based on keywords present in the content, page titles and headings, and metadata such as descriptions and 

tags. 

3. Database 

Function: Stores all indexed data in a centralised repository optimised for rapid retrieval, enabling responses 

to queries within fractions of a second. 

4. Query Processor 

Function: Analyses user queries and retrieves relevant information from the database by interpreting search 

terms, identifying intent, and matching against indexed data. 

5. Ranking Algorithm 

Function: Determines the order in which search results are displayed based on Relevance, Quality, Page 

Authority, Keyword Usage, and User Engagement metrics. 

6. Search Results Interface 

Function: Displays results to the user in an organised format, presenting the page title, URL, and a content 

snippet for each result. 
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Key Components — Summary Table 

Component Function Process 

Web Crawler Browses the web and collects data Visits pages, reads content, follows 

hyperlinks 

Indexing Organizes and stores collected 

data 

Categorizes by keywords, content, and 

metadata 

Database Stores indexed data centrally Maintains optimized repository for rapid 

retrieval 

Query Processor Analyzes user queries Interprets search terms and matches against 

index 

Ranking Algorithm Determines result display order Ranks by relevance, quality, authority, 

engagement 

Search Results Interface Displays results to the user Shows titles, URLs, and content snippets 

 

How a Search Engine Works 

• User Query — The user enters a search term or phrase into the search bar. 

• Query Processing — The search engine analyzes the query to understand user intent. 

• Search and Retrieval — The engine scans its index to locate matching web pages. 

• Ranking — Results are ranked by relevance, authority, quality, and engagement. 

• Display of Results — Ranked results are presented on the SERP with titles, URLs, and snippets. 

 

Popular Search Engines 



Introduction to IT Systems | DRIEMS Polytechnic, Tangi, Cuttack  |  Er. Sambit Kumar Sahoo 

DRIEMS Polytechnic  —  IT Theory  —  Page 12  of  87 

Search Engine Developer / Origin Key Characteristic 

Google Google LLC Most widely used globally; powerful algorithms and vast 

database. 

Bing Microsoft Similar to Google with different ranking algorithms; 

integrated with Microsoft services. 

Yahoo! Yahoo Inc. One of the oldest search engines; now powered by Bing's 

search technology. 

DuckDuckGo DuckDuckGo Inc. Privacy-focused; does not track user activity or store 

personal data. 

Baidu Baidu Inc. (China) Leading search engine in China; tailored for Chinese 

language users. 

 

Types of Web Searches 

Type Purpose Example Queries 

Informational Search To find knowledge or information 

about a topic 
"How does photosynthesis work?", "History 

of the Roman Empire" 

Navigational Search To locate a specific website or 

web page 

"Facebook login", "YouTube" 

Transactional Search To perform an action such as 

purchasing or subscribing 

"Buy iPhone 13", "Netflix subscription" 

 

How Search Engines Work — Detailed Process 

Stage 1: Crawling 

• Automated crawlers begin with known URLs and sitemaps. 

• Crawlers visit pages, read content, and follow links to discover new pages. 

• Crawling is continuous and recurring to keep indexed data current. 

Stage 2: Indexing 

• Content of crawled pages is parsed and analyzed. 

• Keywords, topics, and themes are identified and recorded. 

• A massive searchable index (catalogue) is built. 

• Metadata (title, URL, description) is stored for quick retrieval. 

Stage 3: Ranking 

• Relevance — How closely content matches the query. 

• Authority — Credibility measured by quality external links. 

• User Experience — Page load speed, mobile-friendliness, usability. 

• Freshness — Preference for newer content on time-sensitive topics. 
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• Personalization — Adjustments based on user history, location, preferences. 

Stage 4: Retrieval and Display 

• Query keywords are processed to understand intent. 

• The index is scanned for matching pages. 

• Results are ranked and displayed on the SERP. 

• Snippets (title, URL, description) are generated for each result. 

Stage 5: Continuous Updates and Refinement 

• Algorithms are regularly updated to improve quality. 

• User interaction data (click-through rates, dwell time) is analyzed for refinement. 

 

Search Engine Stages — Summary Table 

Stage Process Description 

Stage 1 Crawling Crawlers discover and gather data from web pages by following links. 

Stage 2 Indexing Data is parsed, categorized, and stored in a structured index. 

Stage 3 Ranking Results are ordered by relevance, authority, experience, freshness, 

personalization. 

Stage 4 Retrieval and Display Results are retrieved from index and displayed on SERP with 

snippets. 

Stage 5 Continuous Updates Algorithms updated; user interaction data analyzed for improvement. 

 

Informational Search Query Operators 

Operator Description Example 

define Returns a definition of the given term define tolerance 

time Returns the current time at a specified location time Australia 

to Converts measurements from one unit to 

another 

12 inches to feet 

in Converts currency or measurement values 650 EURO in INR 

translate Translates words or phrases into a specified 

language 

Translate " Hello world " into Odia 

map Returns a map view of the specified location map Odisha 

stocks Returns stock market information for a 

company 

stock wipro 

weather Returns the weather forecast for a location or 

ZIP code 
weather bodhgaya or 824231 
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Google Advanced Search — Step-by-Step Process 

• Step 1: Open a web browser and navigate to www.google.com. 

• Step 2: Enter the search term in the search box and press Enter to view results. 

• Step 3: Select a content category from the tabs: All, News, Images, Books, Videos, Maps, Flights, 
or Finance. 

• Step 4: Click the Tools button within the selected category to access additional refinement filters. 

• Step 5: Explore other categories and apply their respective filters for precise results. 

 

Category Type of Results Example Filters 

All General web results Time period, verbatim search 

News News articles Date range, source, sorting order 

Images Image results Size, colour, type, usage rights 

Books Book references Preview available, date 

Videos Video content Duration, date, quality, source 

Maps Location-based results Distance, transit mode 

Flights Flight information Date, airline, stops, price 

Finance Financial data Time range, comparison charts 

 

1.3 AWARENESS ABOUT DIGITAL INDIA PORTALS 

What is Digital India? 

Digital India is a flagship initiative launched by the Government of India in 2015 with the vision of 

transforming India into a digitally empowered society and knowledge economy. The program aims to 

harness technology to improve governance, make public services more accessible to all citizens, and 

promote digital literacy across the country. 

 

Objectives of Digital India 

Objective 1: Digital Infrastructure as a Core Utility to Every Citizen 

• High-Speed Internet — Ensuring access to high-speed Internet as a basic right. 

• Digital Identity — Providing a unique digital identity (Aadhaar) for every citizen. 

• Mobile Phone and Bank Account — Enabling widespread access to mobile and banking services. 

Objective 2: Governance and Services on Demand 
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• e-Governance — Reforming government processes through digitization for transparency and 
efficiency. 

• Online Services — Delivering government services through online and mobile platforms. 

• Ease of Doing Business — Simplifying processes for businesses through digital tools. 

Objective 3: Digital Empowerment of Citizens 

• Digital Literacy — Promoting digital skills, particularly in rural and underserved areas. 

• Universal Digital Literacy — Providing training for basic digital skills to every individual. 

• Availability of Digital Resources — Ensuring access to digital content in regional languages. 

 

Objective Focus Area Key Initiatives 

Digital Infrastructure Foundational digital 

infrastructure 

High-speed Internet, Aadhaar, mobile and 

banking access 

Governance on Demand Digital governance reform e-Governance, online services, ease of 

doing business 

Digital Empowerment Digital skills and resource 

access 

Digital literacy, universal training, regional 

content 

 

State Portals 

A State Portal is an online platform created by individual state governments in India to provide citizens 

with access to government services, information, and resources specific to that state. 

 

Key Features of State Portals 

Feature Description 

Access to Government Services Online applications for certificates, tax payments, license applications, and 

grievance redressal with tracking. 

Information and Resources Government notifications, policy updates, downloadable forms, and official 

documents. 

Citizen Engagement Feedback mechanisms, suggestion portals, and discussion forums. 

E-Governance Initiatives Mission Mode Projects such as e-Districts and integrated multi-department 

services. 

Local Language Support Multilingual interface in state official language and English. 

 

How to Navigate a State Portal — Step-by-Step 

• Access the Portal — Open a browser, enter the portal URL, and load the homepage. 

• Explore the Homepage — Review the navigation bar, search bar, main menu, and featured 
services. 

• Access Specific Services — Browse Citizen Services, Department Services, and Quick Links. 
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• Use Search Function — Enter keywords and apply filters to locate services. 

• Register or Log In — Create a new account or log in with existing credentials. 

• Fill Out Online Forms — Select a service, fill in details, upload documents, and submit. 

• Make Payments — Use the payment gateway via card, net banking, or UPI. 

• Track Application Status — Use the reference number to check progress. 

• Download or Print Documents — Retrieve processed documents from the portal. 

• Access Support or Help — Use the Help section, contact details, or FAQs. 

• Log Out — Securely log out after completing all tasks. 

 

College Portal 

A college portal is an online platform provided by educational institutions that allows students, faculty, and 

staff to access academic and administrative services through a centralized digital hub. 

 

Features of a College Portal 

Feature Category Target Users Key Functions 

Student Dashboard Students Profile management, course registration, attendance 

tracking, grades, assignments, exam schedules. 

Faculty Dashboard Faculty Course management, grade submission, attendance 

monitoring, student communication. 

Administrative Services Students, Staff Online fee payment, library access, event calendar. 

Communication Tools All Users Integrated email and messaging, institutional 

announcements. 

LMS Integration Students, Faculty Access to course materials, lecture notes, discussion 

forums. 

Support and Helpdesk All Users Technical support, academic advising, FAQs. 

 

Comparison: State Portal vs. College Portal 

Parameter State Portal College Portal 

Purpose Government services and information 

for citizens 

Academic and administrative services 

for students, faculty, staff 

Target Users General public and citizens Students, faculty, institutional staff 

Services Certificate applications, tax payments, 

grievance redressal 
Course registration, grades, fee 

payment, library, LMS 

Language Support State official language and English Primarily English; may support 

regional languages 
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Parameter State Portal College Portal 

Governance Managed by state government (Digital 

India) 

Managed by institutional 

administration and IT department 

Login Credentials Citizen registration with personal 

details 
Institutional credentials (student ID and 

password) 

 

1.4 GENERAL UNDERSTANDING OF VARIOUS COMPUTER 

HARDWARE COMPONENTS 

Computer System 

A computer system refers to the complete setup that enables a computer to function, comprising both 

hardware and software components working together. The fundamental functional units include the Input 

Unit, Output Unit, Central Processing Unit (CPU), and Memory Unit. 

 

 

Input Unit 

• The user interacts with the computer through the Input and Output units. 

• The Input Unit accepts data from the user in a human-understandable form. 

• It converts the accepted data into a machine-readable form for processing. 

• Common input devices include: Keyboard, Mouse, and Trackball. 

 

Output Unit 

• The Output Unit presents processed data (information) to the user in a human-readable form. 
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• Common output devices include: Monitor (visual display) and Printer (hard copy output). 

 

Central Processing Unit (CPU) 

The CPU controls, coordinates, and supervises all operations of the computer. It consists of three sub-units: 

Arithmetic Logic Unit (ALU) 

The ALU performs all arithmetic and logical operations. It consists of three internal parts: 

• Adder — Where actual arithmetic calculations take place. 

• Register — Stores information temporarily during processing. 

• Accumulator — Holds intermediate results of calculations. 

Operations performed include Arithmetic Operations (Addition, subtraction, multiplication, division) and 

Logical Operations (AND, OR, NOT). 

Control Unit (CU) 

• Controls and maintains the correct sequence of instruction execution. 

• Coordinates the functioning of all other units within the computer. 

• Decodes instructions provided by the user or loaded from memory. 

Register Unit 

• Provides high-speed temporary storage within the CPU. 

• Sometimes called chip memory. 

• Stores data, instructions, addresses, and intermediate results. 

 

CPU Sub-Units — Summary Table 

Sub-Unit Function Key Components / Operations 

ALU Performs arithmetic and logical 

operations 

Adder, Register, Accumulator; +, −, ×, ÷, 

AND, OR, NOT 

CU Controls instruction sequencing and 

system coordination 

Instruction decoding, unit coordination 

Register Unit High-speed temporary storage within 

CPU 

Data, instructions, addresses, intermediate 

results 

 

Microprocessor 

A microprocessor is a silicon chip that integrates the ALU, register circuits, and control circuits onto a 

single integrated circuit (IC). It is capable of receiving data, processing it, and outputting results on a single 

chip. It performs ALU operations and controls memory, input/output devices, and acts as a programmable 

device that processes binary data as per loaded instructions. 
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Memory Unit 

The Memory Unit stores instructions, data, intermediate results, and final output. Data is stored at specific 

memory locations identified by addresses. 

 

Units of Digital Data Measurement 

Unit Symbol Capacity 

Bit b 1 or 0 (on or off) 

Byte B 8 Bits 

Kilobyte KB 1024 Bytes 

Megabyte MB 1024 Kilobytes 

Gigabyte GB 1024 Megabytes 

Terabyte TB 1024 Gigabytes 

Petabyte PB 1024 Terabytes 

Exabyte EB 1024 Petabytes 

Zettabyte ZB 1024 Exabytes 

Yottabyte YB 1024 Zettabytes 

 

Types of Computer Memory 

The Memory Unit is classified into Primary Memory (Main Memory / Internal Memory) and Secondary 

Memory (Secondary Storage / External Memory). 
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1. Random Access Memory (RAM) 

RAM is Volatile Memory — it loses content when power is turned off. 

Type Storage Mechanism Refresh Requirement Speed Cost Common Use 

DRAM Capacitor-based Requires frequent 

refreshing 

Slower Less 

expensive 

Main system 

memory 

SRAM Flip-flop circuits No frequent refreshing 

needed 

Faster More 

expensive 

Cache memory 

 

2. Read-Only Memory (ROM) 

ROM is Non-Volatile Memory — it retains contents even when power is off. 

Type Full Form Programmability Erasure Method 

PROM Programmable ROM Programmed once after 

manufacturing 

Cannot be erased 

EPROM Erasable Programmable ROM Can be reprogrammed after 

erasure 

Erased using ultraviolet light 

EEPROM Electrically Erasable 

Programmable ROM 

Can be reprogrammed 

multiple times 

Erased using electrical charge 

 

3. Cache Memory 

Cache Memory is high-speed memory located close to or within the CPU. 

Level Location Size Speed Sharing 

L1 Cache Within the CPU Smallest Fastest Dedicated to individual core 

L2 Cache On the CPU or nearby Larger than L1 Slightly slower Dedicated to individual core 

L3 Cache On the CPU chip Largest cache 

level 

Slower than L2 Shared among multiple cores 

 

Secondary Memory 

Type Technology Key Characteristics 

HDD Magnetic rotating platters Large capacity, lower cost, slower access 

SSD Flash memory (no moving parts) Faster access, more durable, lower power 

Optical Discs (CD, DVD, 

Blu-ray) 

Laser-based read/write Media distribution, archival; limited capacity 

USB Flash Drive Flash memory Portable, connects via USB 
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Type Technology Key Characteristics 

Memory Cards (SD, 

microSD) 

Flash memory Compact, used in cameras, phones, tablets 

External Hard Drive HDD or SSD (portable) Portable, connects via USB 

Cloud Storage Internet-based remote servers Accessible from any device via Internet 

 

Comparison: Primary Memory vs. Secondary Memory 

Parameter Primary Memory Secondary Memory 

Also Known As Main memory, internal memory Secondary storage, external memory 

Volatility Volatile (RAM); Non-volatile (ROM) Non-volatile 

Speed Very fast; directly accessible by CPU Slower 

Capacity Smaller Much larger 

Purpose Data currently being processed Long-term permanent storage 

Examples RAM, ROM, Cache HDD, SSD, USB, Optical Disc, Cloud 

Data Retention Lost when power off (RAM) Retained without power 

Cost per Unit Higher Lower 

 

Display — Types and Characteristics 

A display (monitor/screen) is an output device that visually presents information generated by a computer, 

including text, images, videos, and graphical interfaces. 

 

Display Type Technology Characteristics Status / Use Case 

CRT Electron beams excite 

phosphor dots on glass 

screen. 

Bulky, heavy, low resolution, 

high power consumption. 

Phased out; replaced by flat-

panel displays. 

LCD Liquid crystals between 

glass layers with backlight. 

Thin, lightweight, energy 

efficient, good resolution. 

Desktops, laptops, 

smartphones, tablets. 

LED LCD with LED 

backlighting instead of 

CCFL. 

Better brightness and contrast, 

energy efficient, slim design. 

Current standard for 

monitors, TVs, mobile 

devices. 

DLP Digital Micromirror Device 

(DMD) for projection. 

Sharp, high-contrast projected 

images. 

Digital projectors, 

classrooms, home theatre. 
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Display Type Technology Characteristics Status / Use Case 

OLED Organic compounds emit 

light; no backlight needed. 

True blacks, superior contrast, 

wide viewing angles, fast 

response. 

High-end smartphones, 

premium TVs, select laptops. 

Plasma Ionized gas cells produce 

light. 

High contrast, wide viewing 

angles, heavier. 

Discontinued; replaced by 

LED and OLED. 

Touchscreen Touch-sensitive layer over 

LCD/LED/OLED. 

Interactive input and output, 

versatile, multi-touch support. 

Smartphones, tablets, kiosks, 

ATMs, 2-in-1 laptops. 

 

Keyboard — Types of Keys and Functions 

A keyboard is a primary input device consisting of keys used for typing text, entering data, executing 

commands, and interacting with the operating system and software applications. 

• Alphanumeric Keys — Letters (A–Z), Numbers (0–9), and Special Characters (@, #, &, *, etc.). 

• Modifier Keys — Shift (capitalizes letters), Ctrl (used for shortcuts like Ctrl+C, Ctrl+V), Alt 
(used for shortcuts and special characters), Fn (accesses secondary functions on laptops). 

• Function Keys (F1–F12) — F1 opens Help, F2 renames selected item, F5 refreshes the page, F12 
opens Save As dialog. 

• Navigation Keys — Arrow Keys (move cursor), Home, End, Page Up/Down, Insert, Delete, 
Backspace. 

• Numeric Keypad — Numbers (0–9), Arithmetic Operators (+, −, ×, ÷), Num Lock toggle, 
Decimal Point, Enter. 

• Special Keys — Enter/Return, Spacebar, Caps Lock, Tab, Esc, PrtScn. 

• Multimedia Keys — Volume Control, Play/Pause, Next/Previous Track, Stop. 

 

Shortcut Keys (Hotkeys) 

Shortcut Action 

Ctrl + C Copy 

Ctrl + V Paste 

Ctrl + X Cut 

Ctrl + Z Undo 

Ctrl + S Save 

Ctrl + A Select All 

Ctrl + P Print 

Alt + Tab Switch applications 

Alt + F4 Close window 

F5 Refresh 



Introduction to IT Systems | DRIEMS Polytechnic, Tangi, Cuttack  |  Er. Sambit Kumar Sahoo 

DRIEMS Polytechnic  —  IT Theory  —  Page 23  of  87 

 

Mouse — Components, Types, and Functions 

A mouse is a pointing input device used to interact with a computer's Graphical User Interface (GUI). It 

enables users to move a cursor on the screen, select items, and perform actions through clicking, dragging, 

and scrolling. 

Components of a Mouse 

Component Location Function 

Left Button Top-left Primary button for selecting, clicking, interacting. 

Right Button Top-right Opens context menus with additional options. 

Middle Button Scroll wheel Special functions (new tab, auto-scroll). 

Scroll Wheel Top-centre Vertical and horizontal scrolling. 

Optical Sensor Bottom Detects movement using LED light. 

Laser Sensor Bottom Higher precision tracking using laser. 

Mouse Feet Bottom Reduces friction for smooth gliding. 

USB Cable (Wired) Rear Stable wired connection. 

Wireless Receiver Internal/Dongle Wireless connection via Bluetooth or USB receiver. 

 

Hard Disk Drives (HDD) and Solid-State Drives (SSD) 

Parameter HDD SSD 

Speed Slower (mechanical parts) Faster (no moving parts) 

Durability Vulnerable to physical damage More durable 

Capacity Up to 16 TB Typically up to 4 TB 

Cost Cheaper per GB More expensive per GB 

Noise Generates noise Silent 

Power Consumption Higher Lower 

Boot Time Slower Faster 
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Other Peripheral Devices 

Category Purpose Examples 

Input Devices Provide data and control 

signals 

Keyboard, Mouse, Scanner, Microphone, Webcam, 

Touchscreen, Graphics Tablet, Joystick, Barcode Reader, 

Fingerprint Scanner 

Output Devices Present processed data to 

user 

Monitor, Printer (Inkjet, Laser, Dot Matrix, 3D), 

Speakers, Headphones, Projector 

Storage Devices Store and retrieve digital 

data 

External Hard Drive, USB Flash Drive, Memory Card, 

Optical Drive, NAS 

Other Peripherals Specialized additional 

functionality 
eGPU, Docking Station, UPS, External Sound Card, 

Modem, Router, Smart Card Reader, Bluetooth Adapter 

 

Type Technology Common Use 

Inkjet Sprays ink droplets onto paper Home/office printing, photo printing 

Laser Uses laser and toner powder High-volume office printing 

Dot Matrix Pins strike ink ribbon on paper Industrial use, invoices 

3D Printer Layers materials from digital models Prototyping, manufacturing, design 
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UNIT 2 

OPERATING SYSTEMS 

OS Concepts • Popular Operating Systems • Linux & Windows Installation 
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2.1 What is an Operating System? 

An operating system (OS) is system software that manages computer hardware and software resources, and 

provides common services for computer programs. 

 

Main jobs of an OS: 

• Controls hardware like CPU, memory, and storage 

• Let users interact with the computer 

• Manages files and folders 

• Runs application programs 

• Protects the computer from unauthorised access 

 

 

2.2 Popular Operating Systems 
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1. Windows 

• Made by Microsoft 

• First released in 1985 

• Latest version: Windows 11 

• Most commonly used OS in the world 

• Has a Start menu for easy access 

• Supports gaming, business, and general use 

• Works with many types of hardware 

 

 

2. macOS 

• Made by Apple 

• First released in 2001 

• Latest version: macOS Sonoma 

• Works only on Apple Mac computers 

• Good for design, video editing, and music 

• Very secure and smooth to use 

• Connects easily with iPhone, iPad, and iCloud 
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3. Linux 

• Created by Linus Torvalds in 1991 

• Free and open-source (anyone can use and modify it) 

• Available in many versions called distributions (Ubuntu, Fedora, Debian) 

• Very secure and stable 

• Used in servers, programming, and cybersecurity 

• Has a powerful command-line interface 

 

4. Other Operating Systems 

• Chrome OS — Made by Google, used in Chromebooks, runs web-based apps 

• Android — Made by Google, used in smartphones and tablets 

• iOS — Made by Apple, used in iPhones and iPads 

 

Comparison Table — Popular Operating Systems 

Feature Windows macOS Linux 

Developer Microsoft Apple Open-source community 

Cost Paid Included with Mac Free 

Ease of Use Easy Easy Moderate 

Customization Moderate Limited Very high 

Security Good Strong Very strong 

Gaming Excellent Limited Growing 

Best For General use, gaming, 

business 

Creative work, Apple 

users 

Servers, programming 
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2.3 Important Terms 

Term Full Form Meaning 

OS Operating System The main software that runs the computer 

GUI Graphical User Interface Visual interface with icons and menus 

CLI Command-Line Interface Text-based interface using typed commands 

Kernel — Core part of OS that talks to hardware 

Open-Source — Software that is free to use and modify 

IoT Internet of Things Devices connected through the Internet 

 

 

LINUX OS INSTALLATION 

2.4 Before You Install 

Always check if your computer meets the minimum requirements before installing any OS. 

 

Requirements for Ubuntu Linux: 

• Processor: 2 GHz or faster 

• RAM: 4 GB minimum 

• Storage: 25 GB free space 

• USB port for installation 

• Internet connection (recommended) 
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2.5 Steps to Install Ubuntu Linux 

 

Step 1: Download Ubuntu 

• Go to ubuntu.com/download 

• Download the latest ISO file (this file contains the full OS) 

Step 2: Create a Bootable USB 

• You need a USB drive (at least 4 GB) 

• Use one of these tools to put the ISO file on the USB: 

 

Your Current OS Tool to Use 

Windows Rufus 

macOS Etcher 
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Your Current OS Tool to Use 

Linux dd command or UNetbootin 

 

 

Step 3: Boot from USB 

• Plug the USB into your computer 

• Restart the computer 

• Press the boot key to enter BIOS settings: 

 

Key Used By 

F2 Dell, Lenovo, ASUS 

F12 Many PCs (boot menu) 

ESC HP 

DEL Custom PCs 

 

• Set USB as the first boot device 



Introduction to IT Systems | DRIEMS Polytechnic, Tangi, Cuttack  |  Er. Sambit Kumar Sahoo 

DRIEMS Polytechnic  —  IT Theory  —  Page 32  of  87 

• Save and exit 

Step 4: Start Installation 

• Ubuntu welcome screen appears 

• Choose Install Ubuntu 

• Select your language and click Continue 

Step 5: Set Up Installation 

• Choose your keyboard layout 

• Select options to download updates and install extra software 

• Choose installation type: 

 

Option What It Does 

Erase the disk and install Deletes everything, installs only Ubuntu 

Install alongside other OS Keeps your old OS, adds Ubuntu (dual boot) 

Something else Manual setup for advanced users 

 

Step 6: Set Time Zone and User Details 

• Select your time zone 

• Enter your name, computer name, username, and password 

• Choose if you want automatic login or password login 

Step 7: Finish Installation 

• Installation begins (takes some time) 

• When done, click Restart 

Step 8: Boot into Ubuntu 

• Remove the USB drive 

• Computer restarts into Ubuntu 

• Log in with your username and password 

Step 9: After Installation 

• Open terminal: Ctrl + Alt + T 

• Update your system using the following commands: 

 

Terminal Commands 
sudo apt update 
sudo apt upgrade 

 

• Install any needed drivers and software 

 

Ubuntu Installation — Quick Summary 
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Step What To Do 

1 Download the Ubuntu ISO file 

2 Create a bootable USB drive. 

3 Boot from USB (change BIOS settings) 

4 Start Ubuntu installation 

5 Choose keyboard, updates, and install type. 

6 Set time zone and create a user account 

7 Wait for installation to finish, restart 

8 Remove the USB, boot into Ubuntu. 

9 Update the system and install software. 

 

Tips for Linux Installation 

• Always back-up your important files before installing 

• For better organisation, create these partitions: 

 

Partition Purpose 

/  (root) Stores OS files 

/home Stores your personal files 

swap Extra memory when RAM is full 

 

• If you have problems, visit Ubuntu's help website 

 

WINDOWS OS INSTALLATION 

2.7 Before You Install Windows 

Check if your computer meets these minimum requirements for Windows 11: 

 

Component Requirement 

Processor 1 GHz, 2 cores, 64-bit 

RAM 4 GB 

Storage 64 GB free space 

Security TPM 2.0 and Secure Boot 
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Component Requirement 

Display 720p resolution 

Internet Required for setup 

 

2.8 Steps to Install Windows 11 

 

Step 1: Prepare USB Drive 

• Go to microsoft.com and download Windows 11 ISO 

• Use Media Creation Tool or Rufus to make a bootable USB 

• USB should be at least 8 GB 

Step 2: Prepare Your Computer 

• Backup all important files 

• Check if your PC supports TPM 2.0 and Secure Boot using the PC Health Check tool 

Step 3: Boot from USB 
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• Plug in the USB drive 

• Restart and press boot key (F2, F12, ESC, or DEL) 

• Set USB as the first boot device 

• Save and exit BIOS 

Step 4: Start Installation 

• Windows Setup screen appears 

• Choose language, time format, and keyboard 

• Click Install Now 

Step 5: Enter Product Key 

• Type your 25-character product key 

• Or click "I don't have a product key" to enter later 

• Select Windows edition (Home, Pro, etc.) 

Step 6: Accept License 

• Read and accept the license terms 

• Click Next 

Step 7: Choose Installation Type 

Option What It Does 

Upgrade Keeps your files and apps, updates the OS 

Custom (Clean Install) Erases everything, fresh installation 

 

Step 8: Set Up Disk Partitions 

• For a clean install, you will see your drives 

• Delete old partitions if needed (this erases data) 

• Create new partition and select it 

• Click Next 

Step 9: Install Windows 

• Windows starts copying files 

• Computer will restart several times — this is normal 

• Wait for installation to complete 

Step 10: Set Up Windows 

• Choose your region and keyboard layout 

• Connect to Wi-Fi or Ethernet 

• Sign in with a Microsoft account or create a local account 

• Create a PIN for login 

• Set your privacy preferences 

Step 11: Finish Setup 

• Windows completes final setup 



Introduction to IT Systems | DRIEMS Polytechnic, Tangi, Cuttack  |  Er. Sambit Kumar Sahoo 

DRIEMS Polytechnic  —  IT Theory  —  Page 36  of  87 

• You will see the Windows desktop 

Step 12: After Installation 

• Go to Settings → Windows Update and install all updates 

• Install any missing drivers from the manufacturer's website 

• Install needed software (browser, office, etc.) 

 

Windows 11 Installation — Quick Summary 

Step What To Do 

1 Download ISO and create a bootable USB 

2 Backup data and check system requirements 

3 Boot from USB (change BIOS) 

4 Select the language and click Install Now. 

5 Enter product key or skip. 

6 Accept license terms 

7 Choose Upgrade or Clean Install 

8 Set up disk partitions. 

9 Wait for Windows to install 

10 Set up region, account, PIN, and privacy. 

11 Desktop appears — setup done. 

12 Install updates, drivers, and software. 

 

Tips for Windows Installation 

• Save your product key — you need it to activate Windows 

• Backup drivers before a clean install, especially network drivers 

• Use Windows Defender for security, or install antivirus software 

 

Comparison: Ubuntu vs. Windows Installation 

Feature Ubuntu Linux Windows 11 

Download From ubuntu.com microsoft.com 

USB Tool Rufus, Etcher, dd Media Creation Tool, Rufus 

Product Key Needed No (free) Yes (paid) 
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Feature Ubuntu Linux Windows 11 

License Free, open-source Paid, proprietary 

Install Options Erase, dual boot, manual Upgrade, clean install 

Updates After Install Terminal commands Settings → Windows Update 

Special Requirements None TPM 2.0, Secure Boot 

 

All Important Terms — OS Installation 

Term Full Form Simple Meaning 

ISO — A file that contains the full OS for installation 

USB Universal Serial Bus Port used to connect devices and bootable drives 

BIOS Basic Input/Output System Old firmware that starts up the computer 

UEFI Unified Extensible Firmware 

Interface 
New and better version of BIOS 

TPM Trusted Platform Module Security chip needed for Windows 11 

Secure Boot — A feature that only allows trusted software to start 

Product Key — 25-character code to activate Windows 

Partition — A divided section of your hard drive 

Swap — Linux partition used as extra memory 

sudo Superuser Do Linux command to run tasks as an administrator 

apt Advanced Package Tool Linux tool for installing and updating software 

Driver — Software that helps the OS talk to hardware 

Dual Boot — Running two OS on one computer 
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UNIT 3 

HTML AND CSS 

HyperText Markup Language • Cascading Style Sheets • Web Page Design 

  



Introduction to IT Systems | DRIEMS Polytechnic, Tangi, Cuttack  |  Er. Sambit Kumar Sahoo 

DRIEMS Polytechnic  —  IT Theory  —  Page 39  of  87 

3.1 What is HTML? 

 

HTML stands for HyperText Markup Language. It is the standard language used to create web pages. 

 

Two key words in HTML: 

• HyperText — Text that contains links (hyperlinks) to other pages or resources. It allows users to 
click and move between different web pages. 

• Markup — A way of adding special instructions (tags) to a document to tell the browser how to 
display the content. 

 

HTML gives structure to a web page. It lets you add headings, paragraphs, images, links, tables, forms, and 

more. 

 

3.2 Structure of an HTML Document 

Every HTML page follows a basic structure: 

 

HTML 
<!DOCTYPE html> 
<html> 
<head> 
    <title>My First Webpage</title> 
</head> 
<body> 
    <h1>Welcome to HTML!</h1> 
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    <p>This is a sample webpage.</p> 
</body> 
</html> 

 

 

Part What It Does 

<!DOCTYPE html> Tells the browser this is an HTML document 

<html> Root element — contains all HTML content 

<head> Contains page title, metadata, and links to CSS 

<title> Sets the title shown on the browser tab 

<body> Contains all visible content shown on the page 

 

3.3 How to Create a Webpage 

Follow these simple steps: 

• Open a text editor (example: Notepad) 

• Write your HTML code 

• Save the file with .html extension (example: index.html) 

• Open the file in any web browser to see your webpage 
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3.4 Basic HTML Tags 

Tags are special codes in HTML that tell the browser what to display. 

 

 

1. Heading Tags 

Used to create headings. <h1> is the biggest, <h6> is the smallest. 

 

HTML 
<h1>Main Heading</h1> 
<h2>Subheading</h2> 
<h3>Smaller Heading</h3> 

 

 

2. Paragraph Tag 

<p> creates a paragraph of text. 

 

HTML 
<p>This is a paragraph of text.</p> 
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3. Bold and Italic Tags 

HTML 
<b>This text is bold</b> 
<i>This text is italic</i> 

 

Tag What It Does 

<b> Makes text bold 

<i> Makes text italic 

4. Line Break 

<br> moves text to the next line. It has no closing tag. 

HTML 
First Line<br>Second Line 

5. Horizontal Line 

<hr> draws a horizontal line across the page. 

HTML 
<p>Section 1</p> 
<hr> 
<p>Section 2</p> 

6. Hyperlinks 

<a> tag creates a clickable link. 

HTML 
<a href="https://www.example.com">Visit Example</a> 

• href — the web address the link goes to 

 

Basic Tags — Quick Reference Table 

Tag Purpose Example 

<h1> to <h6> Headings (big to small) <h1>Hello</h1> 

<p> Paragraph <p>Some text</p> 

<b> Bold text <b>Bold</b> 

<i> Italic text <i>Italic</i> 

<br> Line break Line1<br>Line2 

<hr> Horizontal line <hr> 

<a> Hyperlink <a href="url">Link</a> 
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3.5 Page Setting Tags 

These tags go inside the <head> section and set up the page. 

1. Title Tag 

Sets the title shown on the browser tab. 

HTML 
<head> 
    <title>My Webpage Title</title> 
</head> 

 

 

2. Meta Tags 

Give extra information about the page to the browser. 

HTML 
<head> 
    <meta charset="UTF-8"> 
    <meta name="description" content="Learn HTML basics"> 
</head> 

 

Tag Purpose 

<title> Sets page title on browser tab 

<meta charset> Sets character encoding (use UTF-8) 

<meta name="description"> Gives a short description of the page 

 

3.6 Listing Tags 

Lists are used to display items in an organized way. 



Introduction to IT Systems | DRIEMS Polytechnic, Tangi, Cuttack  |  Er. Sambit Kumar Sahoo 

DRIEMS Polytechnic  —  IT Theory  —  Page 44  of  87 

1. Ordered List (Numbered) 

Uses <ol> tag. Items are numbered automatically. 

HTML 
<ol> 
    <li>Item One</li> 
    <li>Item Two</li> 
    <li>Item Three</li> 
</ol> 

2. Unordered List (Bullets) 

Uses <ul> tag. Items get bullet points. 

HTML 
<ul> 
    <li>Apple</li> 
    <li>Banana</li> 
    <li>Cherry</li> 
</ul> 

3. Definition List 

Uses <dl> tag for terms and their meanings. 

HTML 
<dl> 
    <dt>HTML</dt> 
    <dd>HyperText Markup Language</dd> 
    <dt>CSS</dt> 
    <dd>Cascading Style Sheets</dd> 
</dl> 

 

 

Tag Purpose 

<ol> Ordered (numbered) list 

<ul> Unordered (bullet) list 

<li> List item (used inside ol or ul) 
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Tag Purpose 

<dl> Definition list 

<dt> Definition term 

<dd> Definition description 

 

3.7 Adding Graphics to HTML 

Images are added using the <img> tag. 

1. Image Tag 

HTML 
<img src="image.jpg" alt="Sample Image" width="300" height="200"> 

 

 

Attribute What It Does 

src Path to the image file 

alt Text shown if image cannot load 

width Width of the image in pixels 

height Height of the image in pixels 

2. Background Image 

HTML 
<body style="background-image: url('background.jpg');"> 

This sets an image as the background of the whole page. 
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3.8 Working with HTML Tables 

Tables arrange data in rows and columns. 

Basic Table Example 

HTML 
<table border="1"> 
    <tr> 
        <th>Name</th> 
        <th>Age</th> 
    </tr> 
    <tr> 
        <td>John</td> 
        <td>25</td> 
    </tr> 
    <tr> 
        <td>Jane</td> 
        <td>30</td> 
    </tr> 
</table> 

 

 

Tag Purpose 

<table> Creates a table 

<tr> Creates a table row 

<th> Creates a table header cell (bold, centered) 

<td> Creates a table data cell 

border="1" Adds a visible border to the table 
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3.9 Linking Webpages 

1. Link to Another Page 

HTML 
<a href="page2.html">Go to Page 2</a> 

2. Open Link in New Tab 

HTML 
<a href="https://www.example.com" target="_blank">Visit 

Example</a> 

3. Image as a Link 

HTML 
<a href="https://www.example.com"> 
    <img src="logo.jpg" alt="Logo"> 
</a> 

 

Attribute What It Does 

href The address the link goes to 

target="_blank" Opens link in a new browser tab 

 

3.10 HTML Forms 

Forms are used to collect information from users. 

1. Basic Form with Input Fields 

HTML 
<form> 
    Name: <input type="text" name="name"><br> 
    Email: <input type="email" name="email"><br> 
    <input type="submit" value="Submit"> 
</form> 

2. Text Area (For Longer Text) 

HTML 
<form> 
    Comments:<br> 
    <textarea name="comments" rows="4" cols="50"></textarea> 
</form> 
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Tag / Attribute What It Does 

<form> Creates a form 

<input type="text"> Creates a text box 

<input type="email"> Creates an email input box 

<input type="submit"> Creates a submit button 

<textarea> Creates a large text input area 

name Gives a name to the input field 

rows and cols Sets size of text area 

 

All Important Terms — HTML 

Term Full Form Simple Meaning 

HTML HyperText Markup 

Language 
Language used to create web pages 

HyperText — Text with clickable links to other pages 

Markup — Instructions that tell browser how to display content 

Tag — Code in angle brackets that defines page elements 

Element — A complete HTML tag with content 

Attribute — Extra information added inside a tag 

href Hypertext Reference Specifies the link address in anchor tag 

src Source Specifies the file path for images 

alt Alternative Text Text shown when image cannot load 
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Term Full Form Simple Meaning 

CSS Cascading Style Sheets Language used to style HTML pages 

UTF-8 Unicode Transformation 

Format 8-bit 

Character encoding that supports all languages 

URL Uniform Resource Locator Web address of a page or resource 

 

All HTML Tags — Quick Reference 

Tag What It Does 

<html> Root element of the page 

<head> Contains metadata and title 

<title> Page title on browser tab 

<body> Visible page content 

<h1> to <h6> Headings (big to small) 

<p> Paragraph 

<b> Bold text 

<i> Italic text 

<br> Line break 

<hr> Horizontal line 

<a> Hyperlink 

<img> Image 

<ol> Ordered list 

<ul> Unordered list 

<li> List item 

<dl> Definition list 

<dt> Definition term 

<dd> Definition description 

<table> Table 

<tr> Table row 

<th> Table header 

<td> Table data cell 

<form> Form 
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Tag What It Does 

<input> Input field 

<textarea> Large text input area 

<meta> Page metadata 

 

3.11 Dropdown Box in HTML Forms 

A dropdown box lets users pick one option from a list. 

HTML 
<form> 
    Choose an option: 
    <select name="options"> 
        <option value="1">Option 1</option> 
        <option value="2">Option 2</option> 
    </select> 
</form> 

 

Tag What It Does 

<select> Creates a dropdown list 

<option> Adds an item to the dropdown list 

value The data sent when the form is submitted 

name Gives a name to the dropdown field 

All Form Tags — Quick Summary 

Tag What It Creates 

<form> A form to collect user input 

<input type="text"> A text box 

<input type="email"> An email input box 

<input type="submit"> A submit button 

<textarea> A large text area 

<select> A dropdown list 

<option> An item inside a dropdown list 
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CSS — CASCADING STYLE SHEETS 

3.12 What is CSS? 

 

CSS stands for Cascading Style Sheets. It is a language used to style and design web pages created with 

HTML. 

• HTML gives the structure of a page (what content to show) 

• CSS gives the look of a page (how the content looks) 

 

With CSS, you can control: 

• Colors and fonts 

• Text size and alignment 

• Spacing and borders 

• Page layout and background 

 

3.13 Ways to Apply CSS 

There are three ways to add CSS to an HTML page: 
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1. Inline CSS 

CSS is written directly inside the HTML tag using the style attribute. 

HTML 
<p style="color: blue; font-size: 16px;">This is styled text.</p> 

• Used for quick, one-time styling 

• Applied to one element only 

2. Internal CSS 

CSS is written inside the <head> section of the HTML file using the <style> tag. 

HTML 
<head> 
    <style> 
        body { background-color: lightgray; } 
        p { color: green; } 
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    </style> 
</head> 

• Styles apply to the whole page 

• All CSS code stays inside the HTML file 

3. External CSS 

CSS is written in a separate .css file and linked to the HTML file. 

In HTML file: 
<link rel="stylesheet" href="styles.css"> 

In styles.css file: 
body { background-color: white; } 
p { color: black; } 

• Best method for large websites with many pages 

• Same CSS file can be used for multiple HTML pages 

 

Method Where CSS is Written Best For 

Inline CSS Inside the HTML tag (style attribute) Quick styling of a single element 

Internal CSS Inside <style> tag in <head> section Styling a single HTML page 

External CSS In a separate .css file, linked with 

<link> 

Styling multiple pages (large projects) 

 

3.14 CSS Selectors 

A CSS selector is used to select which HTML element you want to style. There are three main types: 
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1. Element Selector 

Selects all elements of a specific tag. 

CSS 
p { color: red; } 

This makes all <p> paragraphs red. 

2. Class Selector 

Selects elements with a specific class name. Uses a dot (.) before the class name. 

CSS: 
.highlight { background-color: yellow; } 

HTML: 
<p class="highlight">This text is highlighted.</p> 

• One class can be used on many elements 

• Same element can have multiple classes 

3. ID Selector 

Selects one specific element with a unique ID. Uses a hash (#) before the ID name. 

CSS: 
#unique { font-weight: bold; } 

HTML: 
<p id="unique">This is a bold paragraph.</p> 
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• Each ID should be used only once on a page 

 

Selector Symbol Selects Can Be Used On 

Element Selector none (just tag 

name) 

All elements of that tag type Multiple elements 

Class Selector . (dot) Elements with a specific class Multiple elements 

ID Selector # (hash) One element with a unique ID One element only 

 

3.15 CSS Properties 

1. Text Styling 

CSS can change how text looks on a page. 

CSS 
h1 { 
    color: blue; 
    text-align: center; 
} 

 

 

Property What It Does Example 

color Changes text color color: blue; 

text-align Aligns text (left, center, right) text-align: center; 

font-size Changes text size font-size: 16px; 
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Property What It Does Example 

font-family Changes the font type font-family: Arial; 

font-weight Makes text bold or normal font-weight: bold; 

text-decoration Adds underline, overline, etc. text-decoration: underline; 

 

2. CSS Box Model 

The Box Model is a very important concept in CSS. Every HTML element is treated as a rectangular box 

made up of four layers: 

CSS 
div { 
    width: 300px; 
    height: 200px; 
    border: 2px solid black; 
    padding: 10px; 
    margin: 20px; 
} 

 

 

Layer What It Is 

Content The actual content inside the box (text, image) 

Padding Space between the content and the border (inside the box) 

Border The line around the padding and content 

Margin Space outside the border (between this box and other elements) 

Box Model — Layer Order (Inside to Outside): 

• Content (innermost) 

• Padding 

• Border 
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• Margin (outermost) 

 

Box Model Properties — Quick Reference 

Property What It Controls Example 

width Width of the content area width: 300px; 

height Height of the content area height: 200px; 

padding Space inside the border padding: 10px; 

border Border around the element border: 2px solid black; 

margin Space outside the border margin: 20px; 

 

3.16 HTML vs CSS — Comparison 

Feature HTML CSS 

Full Form HyperText Markup Language Cascading Style Sheets 

Purpose Creates the structure of a web page Controls the design and appearance of a 

web page 

Made Of Tags surrounding content Selectors with style rules 

Usage Cannot be used in CSS files Can be used in HTML files 

Focus What content to show How content should look 

Example <h1>Hello</h1> h1 { color: red; } 

 

All Important Terms — CSS 

Term Full Form Simple Meaning 

CSS Cascading Style 

Sheets 

Language used to style and design HTML pages 

Selector — Pattern used to select HTML elements for styling 

Property — The style feature you want to change (color, size, etc.) 

Value — The setting you give to a property (blue, 16px, etc.) 

Inline CSS — CSS written directly inside an HTML tag 

Internal CSS — CSS written inside the head section of HTML file 

External CSS — CSS written in a separate .css file 



Introduction to IT Systems | DRIEMS Polytechnic, Tangi, Cuttack  |  Er. Sambit Kumar Sahoo 

DRIEMS Polytechnic  —  IT Theory  —  Page 58  of  87 

Term Full Form Simple Meaning 

Class — A reusable name given to HTML elements for styling 

ID — A unique name given to one HTML element for styling 

Box Model — Concept showing content, padding, border, and margin layers 

Padding — Space between content and border (inside the box) 

Margin — Space outside the border (between elements) 

Border — Line around the padding and content 

Font — The style of text (type, size, weight) 

 

All CSS Properties — Quick Reference 

Property What It Does 

color Changes text color 

background-color Changes background color 

font-size Changes text size 

font-family Changes font type 

font-weight Makes text bold or normal 

text-align Aligns text (left, center, right) 

text-decoration Adds underline or other text effects 

width Sets element width 

height Sets element height 

padding Adds space inside the border 

margin Adds space outside the border 

border Adds a border around the element 
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UNIT 4 

OPEN OFFICE TOOLS 

Writer • Calc • Impress — Apache OpenOffice Suite 
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4.1 Introduction to Open Office Tools 

Office tools are application software that assist users in regular office jobs such as creating, updating, and 

maintaining documents, handling large amounts of data, creating presentations, and scheduling. Apache 

OpenOffice (AOO) is a free and open-source office productivity suite available in many languages, 

compatible with all major operating systems including Apple macOS, Microsoft Windows, and Linux. 

Using office tools saves time and effort, and many repetitive tasks can be automated easily. 

 

 

4.1.1 How to Install Apache OpenOffice 

• Visit the official Apache OpenOffice website: www.openoffice.org 

• Click the Download button. 

• Select your operating system (Windows, macOS, or Linux), preferred language, and version. 

• The download starts automatically. Run the downloaded installer file. 

• A Customer Information form will appear — fill in your details and click Next. 

• Choose the Setup Type (Typical is recommended for most users) and click Next. 

• Continue through the wizard until the installation completes, then click Finish. 

• A shortcut link will now appear on your desktop. 

 

4.1.2 Advantages of Apache OpenOffice 

Advantage Description 

No Licensing Fees It is completely free software. Anyone can use and distribute it without any 

charge. 

Open Source The source code is openly available for anyone to view, modify, and improve. 

Cross Platform The software can be installed on Windows, macOS, and Linux operating 

systems. 

Extensive Language Support The user interface is available in more than 40 languages including Hindi, 

Tamil, and more. 
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Advantage Description 

Consistent Interface Provides a similar look and feel across all its components for better ease of 

use. 

File Compatibility Supports importing and editing of PDF files and various other file formats. 

No Vendor Lock-in Uses Open Document Format (ODF) and XML — files can be opened in any 

text editor. 

Community Support A worldwide community works to fix issues and enhance the software 

continuously. 

 

4.2 Open Office Writer 

Writer is the word processor component of Apache OpenOffice (AOO). It is a free alternative to Microsoft 

Word and has all the features expected from a modern, fully-equipped word processor. Using Writer, we 

can create documents such as reports, letters, books with contents, diagrams, indexes, agendas, minutes, 

and more. 

 

Writer provides standard word processor features including text entry and editing, spell check, autocorrect, 

and find and replace. 

 

 

4.2.1 Parts of the Writer Interface 

Part Description 

Title Bar Situated at the top of the Writer window. Shows the file name of the current 

document. 

Menu Bar Located just below the Title Bar. Contains menus (File, Edit, View, Insert, Format, 

Tools). Clicking a menu drops it down to display commands. 
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Part Description 

File Menu Contains commands for the entire document: Open, Close, Save, Digital Signature, 

Print, and Export as PDF. 

Edit Menu Contains commands such as Undo, Repeat, Find and Replace, Cut, Copy, and Paste. 

View Menu Controls the display of the document: Print Layout, Web Layout, Full-Screen View, 

and Zoom Control. 

Insert Menu Contains commands for inserting headers, footers, pictures, page breaks, special 

characters, hyperlinks, bookmarks, frames, and objects. 

Format Menu Contains formatting and layout commands using Styles, Paragraph, Bullets, and 

Numbering options. 

Tools Menu Contains utility functions like Spelling and Grammar, Mail Merge, Wizard, 

AutoCorrect, and Options. 

Toolbars Provide quick access to frequently used commands. Can be shown/hidden via View 

→ Toolbars. 

Status Bar Located at the bottom of the workspace. Displays page number, page style, language, 

file save status, digital signature, and zoom controls. 

 

4.2.2 Writer Formula Features 

Formula Description 

=A1+10 Displays the contents of cell A1 plus 10. 

=A1*16% Displays 16% of the contents of A1. 

=A1*A2 Displays the result of multiplying the contents of A1 and A2. 

=ROUND(A1,1) Displays the contents of cell A1 rounded to one decimal place. 

=EFFECT(5%,12) Calculates the effective interest for 5% annual nominal interest with 

12 payments a year. 

=B8-SUM(B10:B14) Calculates B8 minus the sum of cells B10 to B14. 

=SUM(B8,SUM(B10:B14)) Calculates the sum of B10 to B14 and adds the value to B8. 

=SUM(B1:B1048576) Sums all numbers in column B. 

=AVERAGE(BloodSugar) Displays the average of a named range called BloodSugar. 

=IF(C31>140,"HIGH","OK") If C31 is greater than 140 then HIGH is displayed, otherwise OK is 

displayed. 

 

4.2.3 Starting a New Document 

• Via Operating System Menu — Start → Programs → OpenOffice → Writer 
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• Via Quick Starter — Tools → Options → OpenOffice → Menu 

• Via Start Center — Start → Programs → OpenOffice → Start Center 

• Via File Menu — File → New → Text Document (Shortcut: Ctrl+N) 

4.2.4 Saving a Document 

• Select File → Save 

• Select File → Save As 

• Click the Save icon on the toolbar 

• Keyboard shortcut: Ctrl + S 

4.2.5 Closing a Document 

• Select File → Close 

• Click the Cross (×) icon at the right end of the menu bar 

• If the document has unsaved changes, a dialog box will appear — choose Save to save, Discard to 
lose changes, or Cancel to return to the document. 

4.2.6 Printing a Document 

• Quick Printing — Click the print icon on the toolbar to print directly to the default printer. 

• Controlled Printing — Select File → Print or press Ctrl + P to open the print dialog box with full 
options. 

4.2.7 Selection, Cutting and Pasting 

• Keyboard shortcut to Copy: Ctrl + C 

• Keyboard shortcut to Cut: Ctrl + X 

• Keyboard shortcut to Paste: Ctrl + V 

• Menu selection: Edit → Paste 

• Contextual menu: Right-click on text and choose Paste 

 

4.2.8 Character Formatting 

Formatting Option Description 

Font Name Changes the typeface of the selected text. 

Font Size Changes the size of the selected text. 

Bold Makes the selected text bold. 

Italic Makes the selected text italic. 

Underline Underlines the selected text. 

Superscript / Subscript Raises or lowers text relative to the normal text line. 

Increase / Reduce Font Increases or decreases font size step by step. 

Font Color Changes the color of the selected text. 
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Formatting Option Description 

Highlighting Highlights the selected text with a background color. 

Background Color Changes the background color of selected characters. 

 

4.2.9 Paragraph Formatting 

Formatting Option Description 

Align Left Aligns text to the left margin. 

Centered Centers text between margins. 

Align Right Aligns text to the right margin. 

Justified Spreads text evenly between both margins. 

Line Spacing 1 Sets single line spacing. 

Line Spacing 1.5 Sets one-and-a-half line spacing. 

Line Spacing 2 Sets double line spacing. 

Numbering On/Off Turns automatic numbered list on or off. 

Bullets On/Off Turns bullet point list on or off. 

Decrease/Increase Indent Moves the paragraph left or right by one indent level. 

 

4.2.10 Finding and Replacing Text 

The Find and Replace dialog box allows the user to locate specific text and replace it with other text. 

• Find and replace words and phrases. 

• Use wildcards and regular expressions to fine-tune a search. 

• Find and replace specific formatting or paragraph styles. 

• Type the text to find in the Search box and the replacement text in the Replace With box. 

• Keyboard shortcut: Ctrl + H 
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4.2.11 Spelling and Grammar Checking 

• Keyboard shortcut for Spelling and Grammar check: F7 

• AutoSpellCheck checks each word as it is typed and displays a wavy red underline beneath 
misspelled words. 

• Once the word is corrected the red line disappears. 

• Use the Spelling and Grammar dialog to check the entire document or a selected portion. 

• The dictionary language can be changed within the Spelling and Grammar dialog. 

• A grammar checker is not available by default but can be installed as an extension via Tools → 
Language → More Dictionaries Online. 

• Words can be added to the dictionary by clicking Add in the Spelling and Grammar dialog. 

4.2.12 AutoCorrect 

The AutoCorrect function in Writer automatically corrects a long list of common misspellings and typing 

errors as you type. 

• To open AutoCorrect settings: Tools → AutoCorrect Options 

• Common corrections such as 'teh' → 'the' are handled automatically. 

• Custom corrections can be added in the AutoCorrect dialog. 

 

4.3 Open Office Calc 

Calc is the spreadsheet component of Apache OpenOffice (AOO). It contains most of the features found in 

other spreadsheet programs. Spreadsheets allow users to organize, analyze, and store data in tabular form. 

• Multiple individual sheets, each containing cells arranged in rows and columns. 

• Functions that can be used to create formulas for complex calculations. 

• Database functions to arrange, store, and filter data. 

• Dynamic 2D and 3D charts for data visualization. 

• Macros for recording and executing repetitive tasks. 
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4.3.1 Introduction to Spreadsheets, Sheets, and Cells 

Component Description 

Spreadsheet (File) In Calc, files are called spreadsheets. Each spreadsheet can contain many separate 

sheets. 

Sheet Each sheet consists of cells arranged in rows and columns. A spreadsheet can 

have multiple sheets. 

Cell The basic unit of a spreadsheet. Located at the intersection of a column and a row. 

Identified by column letter and row number (e.g., A1, B3). 

Formula Bar Shows the contents or formula of the currently selected cell. Used to enter and edit 

data. 

Sheet Tabs Located at the bottom of the grid. Each tab represents one sheet. Click a tab to 

switch to that sheet — the active sheet tab appears white. 

Name Box Located to the left of the Formula Bar. Displays the address of the currently 

selected cell (e.g., A1). 

 

4.3.2 Freezing and Unfreezing Rows and Columns 

Freezing 

• Click into the cell that is immediately below the row you want to freeze AND immediately to the 
right of the column you want to freeze. 

• Choose Window → Freeze. 

• A bold line will appear indicating the freeze boundary. 

Unfreezing 

• To remove the freeze, choose Window → Freeze again (the checkmark will be removed). 

 

4.3.3 Creating Formulas in Calc 

Formulas in Calc always begin with an equals sign (=). The following table explains the key formula 

elements: 

 

Element Description Example Explanation 

Starting a 

Formula 
Begin any formula 

with an equals sign 

= 

=A1+B1 Adds the values in cells 

A1 and B1. 

Cell Reference Refers to the value 

in another cell. 
=C5 Displays the value in cell 

C5. 

Addition Adds two or more 

values. 

=A1+A2+A3 Sums the values in A1, 

A2, and A3. 
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Element Description Example Explanation 

Subtraction Subtracts one value 

from another. 

=B1-B2 Subtracts the value in B2 

from B1. 

Multiplication Multiplies two or 

more values. 
=A1*B1 Multiplies the values in 

A1 and B1. 

Division Divides one value 

by another. 
=A1/B1 Divides the value in A1 

by B1. 

Functions Built-in calculations 

for specific tasks. 

=SUM(A1:A10) Adds all values from A1 

to A10. 

IF Function Performs a logical 

test. 

=IF(A1>10,"Yes","No") Returns Yes if A1 > 10, 

otherwise No. 

Concatenation Combines text 

strings. 

=A1&" "&B1 Joins values in A1 and B1 

with a space. 

Absolute 

Reference 
Locks a cell 

reference with $. 

=$A$1*B1 Always uses A1 even if 

the formula is copied. 

Nested 

Functions 
Uses one function 

inside another. 
=IF(SUM(A1:A5)>50,"Pass","Fail") Checks if the sum of 

A1:A5 is greater than 50. 

Error Handling Handles errors in 

formulas. 
=IFERROR(A1/B1,"Error") Returns Error if dividing 

A1 by B1 fails. 

 

4.4 Open Office Impress 

Impress is the presentation component of Apache OpenOffice. It creates presentations in ODP 

(OpenDocument Presentation) format, which can be opened by other presentation software or exported in 

different formats. Impress includes a spelling checker, a thesaurus, pre-packaged text styles, and attractive 

background styles. 
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4.4.1 Creating a New Presentation 

• From the Start Center: Click the Presentation icon. 

• From the system menu or AOO Quick Starter. 

• From any other component of AOO: Click the triangle next to the New icon on the toolbar and 
select Presentation. 

• From the menu bar: File → New → Presentation. 

• An empty (blank) presentation will appear. 

• You can choose a design from the list of available templates. 

• In the Presentation Wizard, select a slide design and presentation background. 

• Select the output medium (screen, paper, overhead, slide). 

• Click Next, then click Create — a new presentation is ready. 

 

4.4.2 Parts of the Impress Interface 

Part Description 

Menu Bar Located at the top of the window. Contains menus like File, Edit, View, Insert, 

Slide, and more for accessing all commands. 

Toolbar Positioned below the Menu Bar. Offers quick access to font settings, alignment, 

slide layout, and frequently used tools. 

Sidebar Typically on the right. Provides additional options for slide properties, transitions, 

animations, and master slides. 

Slide Pane Located on the left. Displays thumbnail previews of all slides for quick navigation 

and rearrangement. 

Workspace (Slide Editor) The central area where you design and edit individual slides. 

Status Bar Positioned at the bottom. Shows the current slide number, total slides, zoom level, 

and layout name. 

Navigator Accessed via the View menu. Helps manage slides, objects, and elements in the 

presentation. 

Slide Sorter View Found under the View menu. Shows all slides at once so they can be reordered 

easily. 

Notes View Lets you add speaker notes to each slide. Useful for preparing additional 

commentary. 

Master Slide View Enables editing of slide layouts and themes, which affect the design of multiple 

slides simultaneously. 

Drawing Toolbar Located at the bottom. Provides tools for adding shapes, lines, arrows, and other 

graphic elements. 

Slide Transition Pane Found in the Sidebar. Lets you apply and customize transitions between slides. 
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4.4.3 Formatting a Presentation 

Inserting New Slides 

• Insert → Slide from the menu bar. 

• Right-click on a slide in the Slide Pane and select Slide → New Slide from the pop-up menu. 

• Click the Slide icon in the Presentation toolbar. 

Selecting a Layout 

• Place the slide in the workspace. 

• Select the desired layout from the Layout drawer in the Task Pane. 

• Layouts range from a blank slide to a slide with a title and six content boxes. 

Modifying Slide Elements 

• To insert a picture: Insert → Picture → From File → browse and select the image → click Open. 

• Move and resize the picture as needed. 

• To add text: click inside any text frame and type your text. 

• To remove an element: click on it (green handles show it is selected) then press the Delete key. 

 

4.4.4 Applying Animation Effects 

Start Option Description 

On Click The animation does not start until you click the mouse during the slide show. 

With Previous The animation runs at the same time as the previous animation. 

After Previous The animation runs immediately after the previous animation ends. 

 

4.4.5 Running the Slide Show 

• Click Slide Show → Slide Show from the main menu. 

• Click the Slide Show button on the Presentation toolbar or Slide Sorter toolbar. 

• Press F5 to start from the first slide or F9 to start from the current slide. 

• Use the Right Arrow key or click the mouse to advance to the next slide. 

• Use the Left Arrow key to go back to the previous slide. 

• Press the Spacebar to advance to the next slide. 

• If slide transitions are set to automatic timing, the show will run by itself. 

4.4.6 Printing a Presentation 

• Choose File → Print to display the print dialog. 

• The General tab is used to select the printer and its properties. 

• The Range and Copies options allow printing of specific slides. 

• From the Print drop-down box, select what to print: Slides, Handouts, Notes, or Outline. 
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4.5 Comparison of Open Office Components 

Feature Writer Calc Impress 

Purpose Word processing and 

document creation 

Spreadsheets and data 

analysis 

Presentations and 

slideshows 

File Format .odt (OpenDocument 

Text) 

.ods (OpenDocument 

Spreadsheet) 

.odp (OpenDocument 

Presentation) 

MS Office Equivalent Microsoft Word Microsoft Excel Microsoft PowerPoint 

Main Use Letters, reports, books Tables, charts, 

calculations 

Slides, animations, slide 

shows 

Key Feature Mail merge, styles, PDF 

export 

Formulas, functions, 

charts 

Slide transitions, 

animations 

Shortcut to Save Ctrl + S Ctrl + S Ctrl + S 

 

4.6 All Important Terms — Open Office Tools 

Term Full Form Simple Meaning 

AOO Apache OpenOffice Free and open-source office productivity software suite 

ODF Open Document Format Standard file format used by OpenOffice 

ODT OpenDocument Text File format used by OpenOffice Writer (like .docx) 

ODS OpenDocument 

Spreadsheet 

File format used by OpenOffice Calc (like .xlsx) 

ODP OpenDocument 

Presentation 
File format used by OpenOffice Impress (like .pptx) 

Writer — Word processor component of Apache OpenOffice 

Calc — Spreadsheet component of Apache OpenOffice 

Impress — Presentation component of Apache OpenOffice 

Cell — Smallest unit in a spreadsheet at the intersection of a row 

and column 

Formula — An expression starting with = used to calculate values in 

Calc 

Formula Bar — Bar in Calc that displays the content or formula of the 

active cell 

Sheet Tab — Tab at the bottom of Calc used to switch between sheets 
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Term Full Form Simple Meaning 

AutoCorrect — Feature that automatically fixes common typing and 

spelling errors 

Mail Merge — Feature in Writer to create multiple personalized documents 

from a template 

Slide Pane — Left panel in Impress showing thumbnail previews of all 

slides 

Master Slide — A template slide that controls the design of all other slides 

in Impress 

Transition — Visual effect that appears when moving from one slide to 

the next 

Animation — Movement effect applied to objects or text on a slide 

Status Bar — Bar at the bottom of any AOO component showing 

document information 

Freeze — Feature in Calc to lock rows/columns in place while 

scrolling 
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UNIT 5 

INFORMATION SECURITY BEST PRACTICES 

Cyber Threats • Security Tools • Safe Digital Life Practices 
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5.1 Introduction to Information Security 

What is Information? 

Information is data that has been processed to become meaningful, valuable, and actionable. Examples 

include personal details, bank account information, business secrets, medical records, and government data. 

What is Information Security? 

Information Security is the practice of protecting information from unauthorized access, use, modification, 

disclosure, or destruction. It involves implementing policies, procedures, and technical measures to 

safeguard both digital and physical information assets. 

Goals of Information Security — The CIA Triad 

The three core goals of information security are known as the CIA Triad: 

Goal Description Example 

Confidentiality Ensures that information is accessible only to 

authorized persons and systems. 

Only the account holder can view their 

bank balance. 

Integrity Protects information from unauthorized 

alteration, ensuring it remains accurate and 

trustworthy. 

A financial record cannot be changed 

without authorization. 

Availability Ensures that authorized users can access the 

required information whenever needed. 

A hospital system must be available 

24/7 for patient records. 
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5.2 Threats to Information Security 

5.2.1 Malware 

Malware (Malicious Software) refers to harmful programs designed to damage, disrupt, or gain 

unauthorized access to computer systems and data. 

Type Description Example 

Virus Attaches itself to legitimate programs and 

spreads when the program is executed. 

Corrupts files or locks the operating 

system. 

Worm Self-replicating program that spreads across 

networks without user action. 
Slows down or crashes an entire network. 

Ransomware Encrypts the victim's files and demands 

payment for the decryption key. 
WannaCry attack locked hospitals' patient 

records. 

Spyware Secretly monitors user activity and collects 

personal information. 

Captures keystrokes to steal passwords and 

banking details. 

Trojan Horse Disguises itself as a legitimate program to 

trick users into installing it. 

Appears as a free game but installs a 

backdoor on the system. 

Adware Displays unwanted advertisements and may 

redirect browser searches. 

Pop-up ads appearing constantly while 

browsing. 

 

 

5.2.2 Social Engineering Attacks 

Attack Type Description Example 

Phishing Fraudulent emails that appear to come 

from trusted sources to steal credentials. 

An email pretending to be from a bank 

asking you to verify your account. 
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Attack Type Description Example 

Spear Phishing A targeted form of phishing aimed at 

specific individuals or organizations. 

A fake email from the 'CEO' asking an 

employee to transfer funds. 

Vishing Voice phishing — phone calls that trick 

users into revealing personal 

information. 

A fake call from 'tech support' asking for 

your password. 

Smishing SMS phishing — fraudulent text 

messages containing malicious links. 

A text saying your parcel is held and you 

must click a link to release it. 

Baiting Leaving infected USB drives or media 

in public places to tempt victims. 
A USB labeled 'Salary Details' found in a 

parking lot. 

Pretexting Creating a fabricated scenario to extract 

information from the target. 
Pretending to be an IT technician to get 

login credentials. 

Tailgating Physically following an authorized 

person into a restricted area. 

Walking behind an employee through a key-

card door without swiping. 

 

 

5.2.3 Network Threats 

Threat Description 

Unauthorized Access An attacker gains access to a network without permission, potentially 

stealing or altering data. 

Eavesdropping (Sniffing) Intercepting and reading network communications without the sender's or 

receiver's knowledge. 

Denial-of-Service (DoS) Attack Flooding a server or network with traffic to make it unavailable to 

legitimate users. 

Man-in-the-Middle (MitM) An attacker secretly intercepts and possibly alters communication between 

two parties. 
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Threat Description 

IP Spoofing Disguising a malicious packet with a trusted source IP address to bypass 

security filters. 

 

5.3 Combating Information Security Threats 

Tool / Technique Description 

Firewall Monitors and controls incoming and outgoing network traffic based on 

predefined security rules. 

Data Backup Regularly saving copies of data to external drives or cloud storage to protect 

against data loss. 

Virtual Private Network (VPN) Encrypts the internet connection to provide privacy and security, especially 

over public networks. 

Encryption Converts data into an unreadable format (ciphertext) so that only authorized 

users with the correct key can read it. 

Anti-Virus Software Detects, quarantines, and removes malicious programs from the computer 

system. Must be kept updated regularly. 

Intrusion Detection System 

(IDS) 
Monitors network traffic and system activity to detect suspicious or malicious 

behaviour and raises alerts. 

Intrusion Prevention System 

(IPS) 
Goes one step further than IDS — not only detects threats but also proactively 

blocks and prevents identified attacks. 

Multi-Factor Authentication 

(MFA) 

Requires users to provide two or more verification factors before gaining 

access to a system or account. 

Security Patches / Updates Regular software updates provided by developers to fix known security 

vulnerabilities. 
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5.4 Information Security Best Practices 

5.4.1 General Computer Usage 

Best Practice Description 

Use Strong Passwords Create complex passwords with a mix of uppercase, lowercase, numbers, 

and special symbols. Avoid using birthdays or names. 

Update Software Regularly Keep your operating system, applications, and drivers updated with the 

latest security patches. 

Install Reliable Antivirus 

Software 

Use trusted antivirus programs and keep them updated to protect against 

malware, viruses, and spyware. 

Avoid Untrusted Downloads Download files and software only from verified and trusted sources. 

Enable Firewalls Ensure the built-in firewall is active on your system to block unauthorized 

access. 

Regularly Backup Data Save copies of important files on external drives or cloud storage to prevent 

permanent data loss. 

Avoid Unsecured Networks Use only secure, encrypted Wi-Fi connections. Never perform sensitive 

activities on public Wi-Fi. 

Secure Physical Access Keep your computer in a secure location and always lock the screen when 

leaving it unattended. 

Scan External Devices Scan USB drives, CDs, and external hard drives for malware before 

connecting them. 

Disable Auto-Run Prevent automatic execution of programs from external devices to reduce 

risk. 

Monitor System Activity Watch for unusual activity like slow performance, unknown files, or 

unexpected pop-ups. 

Enable Multi-Factor 

Authentication (MFA) 

Use MFA wherever possible to add an extra layer of security beyond just a 

password. 

 

5.4.2 General Internet Browsing 

Best Practice Description 

Use Secure Websites (HTTPS) Always check for 'https://' and the padlock icon in the URL bar before 

entering personal or financial information. 

Avoid Suspicious Links Do not click on pop-ups, advertisements, or links from untrusted sources. 

Keep Your Browser Updated Regularly update your web browser to ensure it has the latest security 

patches. 
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Best Practice Description 

Use Privacy and Security Settings Enable browser privacy settings to block cookies, trackers, and third-party 

access. 

Be Wary of Phishing Attempts Avoid responding to emails or messages asking for personal or financial 

information. 

Enable Pop-Up Blockers Enable a pop-up blocker in your browser to prevent malicious pop-up 

windows. 

Use VPN on Public Networks Use a Virtual Private Network (VPN) when accessing the internet over 

public Wi-Fi. 

Limit Personal Information 

Sharing 

Do not share personal details like phone numbers, home addresses, or 

financial information unnecessarily online. 

Clear Browsing History and 

Cache 

Regularly delete browsing history, cookies, and cache to protect your 

privacy. 

Use Incognito/Private Mode Use private browsing mode when you do not want browsing history or 

cookies saved. 

Scan Downloads Before Opening Only download files from reputable websites and scan with antivirus before 

opening. 

Avoid 'Remember Me' on Shared 

Computers 
Do not save login credentials on public or shared computers. 

 

5.4.3 Password Management 

Best Practice Description 

Create Strong Passwords Use a mix of uppercase, lowercase letters, numbers, and special characters. 

At least 12–16 characters long. 

Use Unique Passwords for Each 

Account 
Never reuse the same password across multiple websites. 

Avoid Predictable Passwords Avoid common passwords like 'password123', 'admin', '123456'. 

Use a Password Manager Use trusted tools (e.g., LastPass, Bitwarden) to securely store and manage 

passwords. 

Enable Two-Factor 

Authentication (2FA) 

Add an extra security layer requiring a secondary code via SMS, email, or 

authenticator app. 

Regularly Update Passwords Change passwords every 3–6 months or immediately if you suspect a 

breach. 

Do Not Share Passwords Avoid sharing passwords with anyone. 

Avoid Writing Passwords Down Do not store passwords on sticky notes, notebooks, or unencrypted files. 

Log Out from Shared Devices Always log out after accessing accounts on shared or public devices. 
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Best Practice Description 

Check for Password Breaches Use tools like 'Have I Been Pwned' (haveibeenpwned.com) to check for 

credential leaks. 

Enable Biometric Authentication Use fingerprint or facial recognition for added security where available. 

 

 

5.4.4 Removable Information Storage Media 

Best Practice Description 

Scan for Malware Before Use Always scan USB drives, external hard drives, CDs with antivirus software 

before connecting. 

Encrypt Sensitive Data Use encryption to protect sensitive data stored on removable media. 

Backup Data Regularly Maintain backups of important data stored on removable devices. 

Avoid Devices from Unknown 

Sources 

Do not use USB drives or media from untrusted or unknown sources. 

Disable Auto-Run Turn off the auto-run feature for external devices. 

Safely Eject Devices Always use the 'Safely Remove Hardware' option before unplugging. 

Limit Device Sharing Avoid sharing USB drives or external media with multiple users. 

Store Devices Securely Keep removable storage media in a safe place when not in use. 

Use Password Protection Protect removable media with a password to restrict unauthorized access. 

Securely Delete Data When 

Discarding 
Use secure erase tools before discarding or passing on a device. 
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5.4.5 Email Communication 

Best Practice Description 

Avoid Suspicious Emails Do not open emails from unknown senders or those with generic greetings. 

Beware of Phishing Scams Watch for fraudulent emails pretending to be from trusted organizations. 

Do Not Share Sensitive 

Information 

Never send passwords, banking details, or confidential data through email. 

Enable Two-Factor 

Authentication (2FA) 
Secure your email account with 2FA. 

Be Cautious with Attachments Do not open email attachments from unknown senders. Scan with antivirus 

first. 

Avoid Clicking Email Links 

Directly 

Type website URLs directly into your browser instead of clicking email links. 

Regularly Update Your Email 

Password 

Change your email password periodically and use a strong, unique password. 

Monitor for Unusual Activity Check for unauthorized access or unfamiliar sent emails. 

Log Out on Shared Devices Always log out of your email account when using shared computers. 

Avoid Fake Unsubscribe Links Clicking fake unsubscribe links can confirm your email address to attackers. 

 

 

5.4.6 Home Wi-Fi Network Security 

Best Practice Description 

Change Default SSID and 

Password 

Update the default Wi-Fi network name and use a strong, complex 

password. 



Introduction to IT Systems | DRIEMS Polytechnic, Tangi, Cuttack  |  Er. Sambit Kumar Sahoo 

DRIEMS Polytechnic  —  IT Theory  —  Page 81  of  87 

Best Practice Description 

Enable WPA3 or WPA2 

Encryption 

Use WPA3 or WPA2 security protocols. Avoid outdated WEP protocol. 

Change Default Router Login 

Credentials 
Update the default admin username and password for your router. 

Disable Remote Management Turn off remote access to your router settings unless absolutely necessary. 

Enable Router Firewall Use the router's built-in firewall for protection against external threats. 

Keep Router Firmware Updated Regularly install firmware updates from the router manufacturer. 

Set Up a Guest Network Create a separate guest network for visitors. 

Disable WPS Turn off WPS as it has known security vulnerabilities. 

Enable MAC Address Filtering Restrict Wi-Fi access by allowing only specific devices. 

Monitor Connected Devices Regularly review connected devices and disconnect any unfamiliar ones. 

Use a VPN on Your Network Consider using a VPN router to encrypt all traffic on your home network. 

Turn Off Wi-Fi When Not in Use Disable your router when away for extended periods. 

 

5.4.7 Avoiding Social Engineering Attacks 

Best Practice Description 

Be Skeptical of Unsolicited 

Requests 

Do not provide personal information in response to unexpected calls, 

emails, or messages. 

Verify the Source Always cross-check requests by contacting the person through official 

channels. 

Beware of Urgency Tactics Social engineers create false urgency. Always pause and verify. 

Avoid Sharing Sensitive 

Information Publicly 

Do not post personal details on social media or public platforms. 

Educate Yourself and Others Learn about common tactics such as phishing, baiting, pretexting, and 

tailgating. 

Do Not Click Unknown Links Avoid clicking links or downloading attachments from untrusted sources. 

Use Multi-Factor Authentication 

(MFA) 

MFA makes it harder for attackers even if they have stolen your password. 

Verify Financial Transaction 

Requests 

Double-check any request for fund transfers through official channels. 

Shred Physical Documents Shred sensitive documents before discarding them. 

Report Suspicious Activity Notify your organization, bank, or relevant authorities of suspected attacks. 
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5.4.8 Smart Device Security (Smartphones and Tablets) 

Best Practice Description 

Use Strong Passwords or 

Biometrics 
Set a strong PIN, password, or pattern. Enable fingerprint or face 

recognition. 

Keep Device Software Updated Regularly update your device's OS and all installed apps. 

Install Apps from Trusted Sources 

Only 

Download apps only from Google Play Store or Apple App Store. 

Enable Remote Tracking and 

Wiping 

Enable 'Find My Device' or 'Find My iPhone' to locate or erase device if 

lost. 

Be Cautious with Public Wi-Fi Avoid accessing sensitive information over public Wi-Fi. Use a VPN. 

Review App Permissions Regularly check and restrict app permissions. 

Avoid Jailbreaking or Rooting Do not modify your device's OS as it removes built-in security protections. 

Backup Your Data Regularly Store backups on cloud services or an external storage device. 

Disable Bluetooth and NFC When 

Not in Use 

Turn off Bluetooth and NFC to prevent unauthorized wireless connections. 

Enable Automatic Screen Lock Set your device to lock automatically after a short period of inactivity. 

Monitor Battery and Data Usage Sudden spikes may indicate presence of malicious apps running in the 

background. 

Be Wary of USB Connections Avoid connecting to untrusted computers or public charging stations. 

 

5.4.9 Social Networking Security 

Best Practice Description 

Set Strong Privacy Settings Adjust privacy settings to control who can see your posts and personal 

information. 

Be Cautious with Personal 

Information 

Never share your home address, phone number, or travel plans on social 

media. 

Use Unique Strong Passwords + 

2FA 

Set strong, unique passwords and enable 2FA for each social media 

account. 

Be Aware of Phishing on Social 

Media 
Be cautious of messages asking for personal or financial information. 

Monitor Tagged Photos and Posts Review photos and posts you are tagged in. 

Limit Third-Party App Access Regularly review and revoke access for third-party apps connected to your 

accounts. 
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Best Practice Description 

Verify Friend Requests Carefully Always verify the identity of new contacts before accepting requests. 

Think Before You Post Anything posted online can spread widely and may be impossible to fully 

delete. 

Log Out on Shared Devices Always log out of social media accounts when using shared or public 

devices. 

Monitor Account Activity Regularly check your account for unusual activity. 

 

5.4.10 Instant Messaging (IM) Security 

Best Practice Description 

Enable 2FA on Messaging Apps Enable two-factor authentication and use a strong, unique password. 

Be Cautious with Unknown 

Contacts 
Do not engage with unknown contacts unless you can verify their identity. 

Do Not Share Sensitive 

Information 

Never send passwords, financial details, or personal identification via 

messaging apps. 

Use End-to-End Encrypted 

Platforms 

Choose apps that provide end-to-end encryption (e.g., Signal, WhatsApp). 

Verify Links Before Clicking Be cautious of links sent via IM, especially from unexpected sources. 

Keep Messaging Apps Updated Update apps and your device OS regularly. 

Avoid Public Wi-Fi for Sensitive 

Chats 

Use a VPN if public Wi-Fi is unavoidable. 

Disable Auto-Download of Media Turn off auto-download for images, videos, and files in messaging apps. 

Use Disappearing Messages Use disappearing message features for secure temporary communication. 

Block and Report Suspicious 

Contacts 

Block contacts that send spam or phishing attempts. 

 

5.4.11 Online Transactions and ATM Usage 

Online Transactions — Best Practices 

Best Practice Description 

Use Only Secure Websites 

(HTTPS) 

Always check for 'https://' and the padlock symbol before entering financial 

information. 

Check for Valid SSL 

Certificate 
Ensure the website has a valid SSL certificate confirming encrypted 

connection. 
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Best Practice Description 

Enable 2FA on Banking Apps Enable 2FA on your online banking and shopping accounts. 

Use Trusted Payment Methods Use secure gateways like PayPal, verified credit cards, or UPI apps. 

Monitor Bank Statements 

Regularly 

Check statements frequently for any unauthorized transactions. 

Avoid Saving Payment 

Information 

Do not save credit card details on e-commerce websites. 

Keep Device and Browser 

Updated 
Ensure device and browser are updated with the latest security patches. 

Avoid Phishing Attempts Never click on links in emails or messages asking for financial details. 

 

ATM Usage — Best Practices 

Best Practice Description 

Protect Your PIN at All Times Cover the keypad with your hand when entering your PIN. 

Use ATMs in Safe Locations Use ATMs inside bank branches or well-lit secure public areas. 

Inspect the ATM for 

Tampering 
Check for unusual attachments on the card slot or keypad before inserting 

your card. 

Always Collect Your Card and 

Receipt 

After every transaction, collect your card, cash, and receipt. 

Report Lost or Stolen Cards 

Immediately 

Contact your bank immediately to block the card. 

Monitor Your Bank Statements Check for unauthorized ATM withdrawals and report discrepancies 

immediately. 
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5.4.12 Using Public Computers Safely 

Best Practice Description 

Avoid Entering Sensitive 

Information 
Do not enter passwords, credit card numbers, or banking details on public 

computers. 

Delete Personal Files and 

Browser History 
After your session, delete files, clear history, cookies, and cache. 

Check for Keyloggers Check for unusual hardware attached to the computer before typing 

sensitive data. 

Verify Antivirus is Installed and 

Updated 

Check that the public computer has up-to-date antivirus software. 

Always Log Out After Use Properly log out of all accounts and close all browser windows. 

Never Save Passwords Do not select 'Remember Me' or 'Save Password' on any website. 

Use Private/Incognito Browsing 

Mode 

Use the browser's private mode to prevent saving browsing history. 

Use a VPN if Available Use a VPN to encrypt your internet connection on public computers. 

Be Cautious with USB Devices Avoid connecting personal USB devices to public computers. 

 

5.5 All Important Terms — Information Security 

Term Full Form Simple Meaning 

CIA Triad Confidentiality, Integrity, 

Availability 

The three core goals of information security. 

Malware Malicious Software Software designed to damage, disrupt, or gain 

unauthorized access to systems. 

Virus — Malware that attaches to programs and spreads when 

the program runs. 

Ransomware — Malware that encrypts files and demands payment for 

decryption. 

Phishing — Fraudulent emails or websites designed to steal login 

credentials or personal information. 

Spear Phishing — Targeted phishing attack aimed at a specific individual 

or organization. 

Vishing Voice Phishing Phone call-based social engineering attack. 

Social Engineering — Psychological manipulation of people into revealing 

confidential information. 
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Term Full Form Simple Meaning 

Firewall — A security system that monitors and controls network 

traffic based on rules. 

VPN Virtual Private Network Encrypts internet traffic for privacy and security. 

Encryption — Converting data into an unreadable format to prevent 

unauthorized access. 

MFA / 2FA Multi-Factor / Two-Factor 

Authentication 

Requiring more than one form of verification to access 

an account. 

IDS Intrusion Detection System Monitors network traffic to detect suspicious activity. 

IPS Intrusion Prevention 

System 

Detects and actively blocks identified threats. 

SSL Secure Sockets Layer Encrypts communication between browser and web 

server. Shown as https and padlock. 

HTTPS HyperText Transfer 

Protocol Secure 

Secure version of HTTP using SSL/TLS encryption. 

DoS Attack Denial-of-Service Attack Flooding a server to make it unavailable to legitimate 

users. 

WPA2/WPA3 Wi-Fi Protected Access 2/3 Security protocols used to encrypt Wi-Fi network 

connections. 

Skimmer — A device attached to an ATM card slot to illegally 

capture card data. 

Keylogger — Software or hardware that records keystrokes to steal 

passwords. 

Biometrics — Security verification using unique physical 

characteristics like fingerprints or facial features. 

End-to-End Encryption E2EE Encryption where only sender and recipient can read 

messages. 

 

5.6 Quick Reference — Security Best Practices Summary 

Context Top 3 Best Practices 

General Computer Usage Strong passwords | Regular updates | Enable firewall & antivirus 

Internet Browsing Use HTTPS only | Avoid suspicious links | Use VPN on public Wi-Fi 

Password Management Unique passwords per account | Use password manager | Enable 2FA 

Removable Media Scan before use | Encrypt sensitive data | Disable auto-run 



Introduction to IT Systems | DRIEMS Polytechnic, Tangi, Cuttack  |  Er. Sambit Kumar Sahoo 

DRIEMS Polytechnic  —  IT Theory  —  Page 87  of  87 

Context Top 3 Best Practices 

Email Communication Beware phishing | Scan attachments | Never share credentials via email 

Home Wi-Fi Change default SSID/password | Use WPA3 | Disable WPS 

Social Engineering Verify requests | Be skeptical of urgency | Use MFA 

Smart Devices Use biometrics | Official app stores only | Enable remote wipe 

Social Networking Strong privacy settings | Think before posting | Enable 2FA 

Instant Messaging End-to-end encrypted apps | Disable auto-download | Verify links 

Online Transactions Use HTTPS sites | Use trusted payment gateways | Monitor statements 

ATM Usage Cover PIN entry | Inspect for skimmers | Report suspicious ATMs 

Public Computers Use incognito mode | Always log out | Never save passwords 
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